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® Introduction

Requirements 6
Support 7

This manual provides step-by-step instructions for performing cell count
based normalization of Seahorse XF data using Agilent's Seahorse XF
Imaging and Cell Counting Software. This software automates the process
of performing brightfield and fluorescence image acquisition as well as the
calculation of cell counts in Seahorse XF microplates.

The Seahorse XF Imaging and Cell Counting Software is a required
component of the XF Imaging and Normalization System.

Additionally, new features added to WAVE have been incorporated into this
user manual so that researchers can use this as a guide for performing
more successful cellular metabolism assays.

Mew Seahorse XF
Imaging and Cell
Counting Software

["ew Controller
Win10, 64-bit

Integrated
Imaging and

Metabolit
Cytation 1 or

Cytation s

Seahorse XFe?d
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1  Introduction

Requirements

Required Hardware

e XFe Controller Windows 10, 64-bit
e XFe96 or XFe24 Analyzer
* Handheld Barcode Wand

¢ BioTek Instrument's Cytation 1 Cell Imaging Multi- Mode Reader
OR

BioTek Instrument's Cytation 5 Cell Imaging Multi- Mode Reader

Required Software

¢ XFe Controller Software Version 2.6 (or greater)
e Wave Desktop Software Version 2.6 (or greater)
¢ Seahorse XF Imaging and Cell Counting Software Version 1.0

* Genb 3.0.4 (Version 530407) Software
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Introduction 1

Support

Agilent Cell Analysis (Seahorse) Support

Email: seahorse.support@agilent.com

USA and Canada
1-800-227-9770; select option 3 then 8

Europe

UK: 0800 096 7632
Denmark: +45 8830 5083
Germany: 0800 180 66 78
Netherlands: 0800 022 7243
Other EU: +45 3136 9878

BioTek Instruments, Inc. Support
Email: TAC@biotek.com

Phone: (800)242- 4685
(800)655- 4740

Or see BioTek's support page, here.
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® New Features in Wave

Well View/Import Images 10
Flagging 10

Heat Maps 11

Compare Wells 12

Compare Sets 13

Import Cell Counts 14

Save .asyr file with images 15

This section gives an overview of new image integration and normalization
features in Wave.
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2  New Features in Wave

Well View/Import Images

Flagging

10

Wave 2.6 supports the addition and association of well images through the
Cell Imaging application. Upon completion of XF Assay, import and view
collected images by adding the Well View from the Add View tab. In this tab,
all image sets are visible on the left (Set refers to a single read of a cell
plate. One plate's file can accommodate multiple sets of images). After
selecting an image set, any images collected in the Cell Imaging application
may be imported to a plate's Wave assay file. Select the entire plate or
specific wells before clicking Import Selected.

Importing images may take several minutes. Images that have been imported are in a
compressed format. Full resolution images can be exported from the Cell Imaging
application.

Upon review of images in Wave, individual wells can be flagged for further
review. When one well is in view, simply click the star in the upper
right-hand corner of the image. The flag will be applied to the well
throughout the different review screens in Wave. Note that this will not
remove or adjust the data for this well. Additionally, in the Well View tab,
flags created in the Cell Imaging application environment can be imported
by clicking Import Flags.
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Heat Maps

New Features in Wave 2

Heat Maps allow a quick graphical view of cell count data. Color
saturation of the well is indicative of the value of the cell count. A higher
cell count will result in a darker shading of the well. Heat Maps may be
viewed by group or across the entire plate. You can quickly identify if a
few wells are significantly different from the rest of the group. The options
are shown in the Well View tab. An example is shown below with the Heat

Map selection menu highlighted.
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Figure 1  Well View tab with Heat Map menu
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2  New Features in Wave

Compare Wells

To compare the images of two or more wells, simply select the wells you
wish to view, and then click Compare Wells. This will open an image viewer
with all selected images.

Use the options on the left-hand bar of the viewer to toggle to a more
detailed view. Click on one well to view it with more details.

Wells can only be compared within the same image set.

Agilent Technologies Wave Well Image Viewer =0 X

F11  Bnghtfield 2018-02-16T11:05:23 2 X

Well F11
Image Set | Brightfield 2018-02-16T11:05:23
Cell Count 12325
File

Fl1jpg —————
G11 Brightfield 20 ¥ B x
Image Date |2/22/2018 3:25:57 PM

Plate 16Feb2018 Pheno Test AS49&HepG2

Zoom O
Contrast O

Brightness () H11 Brightfield 20 ¥ B x

Figure2 Compare Wells view
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New Features in Wave 2

Compare Sets

To see all images of a single well that have been collected, select the well
you wish to view, and then click Compare Sets. This will open an image
viewer with all the collected images of that specific well.

Agilent Technologies Wave Well Image Viewer - o X

F11  Brightfield 2018-02-16T11:05:23 B x F11  Cell Count 2018-02-16T12:22:47 B x

Figure3 Compare Sets view
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2  New Features in Wave

Import Cell Counts

Once fluorescent images and cell counts have been collected, the counts
are available for normalization.

1 Navigate to the Normalization tab. There will be an icon to alert if cell
counts are available for the plate.

2 Click Import and the normalization table will fill with cell counts.

Notice that any wells defined as background correction wells in the
assay plate map do not show a cell count - the default count for any
background wells is 0. The scale factor imports as a factor of 1,000
Cells.

Wave 26.0

2018Feb16 Pheno Kit_AS49._ 2018Feb09_Support Training...

Edit Normalization Mode

Normalization Unit Scale Factor

1000 Cells 1000

Normalization Values

Select All ‘ 1 2 3 4 5 6 7 8 El 10 11 12
TEn A 3312 5072 5,884 7,643 5,961 4,270 5,747 8,028 10,633 11,842
B 3320 4793 63990 7,320 5,483 4185 6826 9,538 183271 11968
Clear All Data
c 3317 5,153 7,524 8155 10,177 4333 6177 8,356 12,198 11,750
Cell count data D 2,449 4,901 7,954 7,780 10,633 3,506 5,306 10,429 11,375 14392
available
E 33 4,549 8177 7,583 10,841 4,552 5,869 7,895 17 12,300
Import
F 3,228 4,343 7,847 7,401 10,919 4524 7246 8,552 11542 12325
G 2572 4,592 7873 7,194 10,796 4771 9331 8,563 11,846 13,015
H 3291 4048 6548 7,609 11538 4389 6,689 7353 8351 13378

A
Figure4 Normalization tab with cell counts imported
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New Features in Wave 2

Save .asyr file with images

Plate Name: 16Feb2018 Pheno Test A549&HepG2
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After importing images into Wave from the Cell Imaging application, notice
that Wave will keep track of the images and file size in the Well View tab.
The file must be saved after image import in order to export the data file
with images. Note that upon importing the images to Wave, they are
compressed from their original versions.
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Figure5 Well view tab with imported images
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This section reviews some useful features in the Cell Imaging application.
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Seahorse XF Imaging & Cell Counting Software

Software Introduction

18

Getting started

The Agilent Seahorse Integrated Imaging and Metabolic Analysis Solution
requires the parallel use of both Agilent Seahorse XFe Analyzer and
BioTek Cytation 1 or Cytation 5 instruments. This section assumes that
the appropriate field specialists have installed the instruments and
familiarized the users with their operation. Both instruments are operated
using the same 64-bit, Windows 10 OS controller. This section outlines
recommendations for powering on the systems and setting up save
locations for files.

Powering the system

The following is a recommendation of the order in which each instrument
should be powered on. Assuming all instruments and controller are
powered off:

1 Ensure all components are connected: power cords, 1 USB for XFe,
2 USB for Cytation instrument, 1 serial cable for XFe, and 1 USB for
external barcode wand. Additionally, if using a hardwired LAN
connection, connect an ethernet cable.

2 Power on the controller, and log into the Windows system.
3 Power on the XFe Analyzer.

a After switching the analyzer on, wait a few moments before opening
Wave.

b While the software is initializing, listen for the motor to move, and
check for connectivity status in the status bar. This may take a few
minutes.

¢ If there are problems with connectivity, contact Agilent Support.

The XFe Analyzer requires time to reach operating temperature and equilibrate. It is
recommended that the instrument be turned on the day before an assay is planned to allow
for adequate equilibration.

4 Power on the Cytation 1 multimode plate reader.

a Open XF Imaging and Cell Counting. The camera will initialize, the
instrument may chirp and open the tray.

b To close the tray, press the button next to the door.

¢ Watch for connectivity in the status bar of the XF Imaging & Cell
Counting software.

d If there are problems with connectivity, close XF Imaging & Cell
Counting and try connecting the instrument with Gen5. For further
problems, contact BioTek Support.

Agilent Seahorse XF Imaging and Cell Counting Software User Guide



Seahorse XF Imaging & Cell Counting Software 3

Image storage location

Image Library (This contains all raw images collected by the Cytation)

Because of the number of large image files that are created using this
system, both Agilent and BioTek require that users move the image library
off the controller’s hard drive and either onto a multi-terabyte external
hard drive, or to a network location. If the hard drive runs out of space,
it will affect software performance. The Image Library must be set up
through Genb. To change the image library file path, go to: System >
Preferences > Image Save Options in Genb.

See Figure 6 for help navigating this menu. For further assistance, contact
BioTek.

System Preferences X

File Storage Image Save Options
Preferred File Locations

Default Data Formats

Object Highlight Setings e TRERE T
384/1536 Matrix Display
User Experience

Pathname; [ 2 Wsers\publiciDocuments Cytation mages [Browse...

Read From File Settings
Plate D ond Barcode Preferences
OLE Automation
) Report / Export Preferences
Export Engine:
Auto Content - Main
Auto Content - Patient / Sample Report
Copy to Clipboard
Quick Export
) Preferred Well Analysis Steps
Kinetic Analysis
Spectrum Analysis
Linear Scan Analysis

Experiment Folder

Name [<oATE> TV _owERET> I

Example: | 180813_130355_EXPERIMENT ]

Plate Folder

MName: [ <oaTE>_<TvE>_cPLATE> I

Example: | 18013 130355 Plate 1 ‘

Image File Naming Convention
rame: [<VELL>_<READ STES SEQLENCE> <CHANEL 056> _<IMAGE I WAL DSV _<CHAELs 50 0] »

Ares Scan Analysis Example: [A1.01 1 1 DAPL00LF ]
& Initial Protocol Settings

Plate Lsyout Well IDs

Calculation Options

Status Strings

Image Save Options

Corcel hosly b

Figure 6 Image Save Options
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Seahorse XF Imaging & Cell Counting Software

XF Imaging & Cell Counting Image Database

Upon installation of XF Imaging & Cell Counting Software and Wave, an
image database will be created. This database allows Wave to identify the
correct image files for plates that have been imaged, and import those
images and cell counts into the assay file. The default location for the
database is on the computer's hard drive. If assay review and image
import are completed away from the controller (for example, on a PC with
Wave Desktop), the database must be moved to either a network location
or a portable hard drive. Use the help menu in XF Imaging & Cell
Counting and the Options menu in Wave to change the image database
location, then restart both software programs. If a new file path is chosen,
a new database will be created once the images are collected using XF
Imaging & Cell Counting software. Figure 7 shows a screenshot of the
Wave Options menu.

Figure 7 Wave Options Menu

If the database is changed after images were collected, import the images to .asyr files prior
to moving the database. Alternatively, find the existing database and move it to the new file
path.

Image library and database location setup examples

the following examples to help set up the image library and database
locations:

Removable USB Storage Device Configuration:

Wave -> Options -> Database:
C:\Users\Admin\AppData\Local\Vortex\Database

Agilent Seahorse XF Imaging and Cell Counting Software User Guide
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Imaging & Cell Counting -> Help -> Database:
C:\Users\Admin\AppData\Local\Vortex\Database

Gen5 (Image Library)-> Settings - > Image Save Options:
D:\Gen5 Images

Networked Devices

If you are networking your Controller so that you can import cell counts
and images remotely, the Imaging & Cell Counting database and Genb
image library must be in a shared directory. For example, set up two
shared directory locations:

\\shared server\shared directory\Vortex\Database
\\shared server\shared directory\Images
The settings in the software applications must reflect these directories:
Wave -> Options -> Database:
\\shared server\shared directory\Vortex\Database
Imaging & Cell Counting -> Help -> Database:
\\shared server\shared directory\Vortex\Database
Gen5 (Image Library)-> Settings - > Image Save Options:

\\shared server\shared directory\Images

Home screen

Cell Imaging and Normalization

Scan Plate to Start View/Manage Pictures

Status Bar

Figure 8 XF Imaging and Cell Counting Home Screen

Figure 8 on page 21 shows the main menu of the XF Imaging and Cell
Counting Software. In this view, there are three sections of the screen that
are interactive (each highlighted in yellow boxes).
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Seahorse XF Imaging & Cell Counting Software

Status bar

The bottom left section of the screen reveals the status of the instrument
and software. This bar is available through all data collection and review
screens as well. It is displayed from top to bottom as follows:

Current temperature

The internal incubation temperature of the Cytation instrument is
shown.

Temperature control

The instrument heater status is shown (On or Off). To open options for
turning the heater on/off, and setting the temperature, click the icon or
text.

Note that the imaging protocols require the Cytation 1 temperature to be 37 °C during image
collection.

Connection status

The connection status continually checks connections to both the
handheld Barcode Wand and BioTek’s Genb software. If either of these
is disconnected, the icon turns red, and the software will be “Not
Ready.”

Cytation tray control

To manually open and close the Cytation tray, click the Cytation tray
icon.

Help menu

Open the help menu for support and software information. For more
details, see “Help menu" on page 23.

Scan plate to start

This section shows how to scan the plate barcode and place the plate on
the tray holder to begin imaging protocols. This section is not interactive
from the controller, a barcode must be scanned.

View/Manage pictures

This menu displays the four most recent image sets. To review previously
imaged cell plates, click one of the sets shown or the View All button.

Agilent Seahorse XF Imaging and Cell Counting Software User Guide
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Help menu

Support Software Info

Figure9 Help menu

The following paragraphs define the sections of the help menu.

Support

Use this section to find the phone number and email address to contact a
member of our support team to assist you. Additionally, use the link to
the Agilent Support website to find some technical resources.

Save system files

If the Technical Support team requests system files, use this button to find
and send the appropriate files. The Test Barcode Wand button reveals an
image of a barcode - use this to test the handheld barcode wand. Simply
use the barcode wand to read the barcode displayed on the Controller's
screen.

Software information

Details in this section display software and license information. This is
where the MAC address, which is needed during XF Imaging and Cell
Counting Software licensing, is found.

Image database

This section of the help menu displays the file path for the image
database. This database must be the same in Wave (this can be found in
Wave’s Options menu). If the database location is changed, both XF
Imaging and Cell Counting and Wave software should be restarted.

Agilent Seahorse XF Imaging and Cell Counting Software User Guide 23



3 Seahorse XF Imaging & Cell Counting Software

Features

Flagging

Upon review of both brightfield and fluorescently stained images,
individual wells can be flagged for further review. For example, a
brightfield image reveals one well is not as confluent as another; the well
may be flagged in Cell Imaging by clicking the upper right-hand corner of
the image during review, and the flags can then be imported into Wave.

Masked Images

Upon completion of fluorescent image scans, images may be reviewed for
cell counting accuracy in Cell Imaging software. In this view, the option to
View Counted Cells is available by clicking the checkbox in the lower
right-hand section of the screen. (This feature is only available
immediately after fluorescent images are collected; these are not saved, so
they cannot be reviewed later). The overlay highlights the counted objects

in the images to show efficacy of the counting algorithm.

Agilent Technologies Cell Imaging 0.4.0.7

Fluorescence Image Acquisition

Cell Count 2018-02-23T14:44:06 Well Image: D06
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Figure 10 Viewing counted cells
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Workflow

The procedure outlined in this guide assumes working knowledge of the
XFe Analyzer and XF Assay Kits. This procedure can be adopted for use
with any XF Assay Kit. For instructions on XFe Analyzers, Wave, and XF
Assay Kkits, refer to each item's user manual. For more information on
basic procedures needed to run an XF Assay, see the "Procedures to Run
an XF Assay" on the Agilent Technologies, Inc. website, here.

The flowcharts in Figure 11, Figure 12, and Figure 13 display the XF
Assay workflow with the Imaging and Cell Counting Application for
Normalization.

Imaging and Cell Counting Workflow | 3-4daysistypicaltocomplete this
11818 workflor

WL

o Seed Plate o Incubate Cells o rdedia :(x;hange, ° Scan Barcode ° Put plate in Cytation
Wait for cells to attach Plate is incubated in a CO2 mage & De-gas Run Imaging and Cell

incubator until media exchange Counting from Controller
(30 minutes before running)

Media in the cell plate is exchanged

i
A
|

. — = i Once scan is complete it can stay in the
Perform Brightfield Scan [ePP—— = o [ Cytation (Non CO2 incubator) to de-gas.
Brightfield - m— e — [ e De-Gas timer 1 hour from

start of scan

During downtime while degassing:
. - Load injection ports on the cartridge,
one with stain
- Place cartridge with utility plate (with

[[7) santard gnnstescan calibrant), into XF and run calibration
Q Calibration 20 minutes
Live preview of images during scanning. User can flag wells. - When outgassingis done moue the plate
Image set is stored en the Controller for access by Wave. User from the Cytation to the XF Analyzer

can also export scans directly from the App to a graphic file
(TIFF, JPG, etc)

Please note there may be more than 1 image set depending
on cell type and growth duration.

Figure 11 Imaging and cell counting workflow (1 of 3)
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Imaging and Cell Counting Workflow 34':“5 is typical to complete this
WOl

11818 flow.

o XF Run D;;"!B XF Run: magingand o XF Run Complete o Scan Barcode e Pu(l:Pla:;e
- Review images in Imaging an
Plate is placad in XF for Assay Run. 5 Eine Remove stained plata from XF in Cytation

Cell Counting Ar
Confirm design with staining - FEg b‘:ji“w:gﬁs o
injection. Run Assay.

N

perform Fluorescence calculation of cell count Scan Complete. Go to Wave Edit Normalization Data
& Cell Count Scan —
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Alternately, user can export scans directly from

the Imaging and Cell Count App to a graphic (TIFF,
about 20-20 minutes. Images and cell JPG, ete) file.

counts appear at the end of the scan.
Cell Count masks are viewable. User
can flag wells.

Processing of call count should take

Figure 12 Imaging and cell counting workflow (2 of 3)
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Imaging and Cell Counting Workflow | 3-4daysistypical to complete this

workflow.

11818

@ Images View @ Comparing
User can add Images View from the finished assay ribbon. User can compare multiple images from within a sat or Compare Sets to see what how one well

and get up close on specific images and their data.

compares across all sets.

From the Image View user can see available image sets,
select well images, compare them and embed them.
Users can also view cell count data.

@ Cell Counts @ Embeding 0 Transfer ASYR to Desktop @ Manage
User can view cell counts and visualize comparisons with User can embed images into the Assay Once images have been imported into User can return to Imaging and Cell
Heat Maps based on Groups or the entire plate. for future analysis in Wave Desktop. an assay, the images are embeded Counting App to manage images
into the ASYR file. The Assay can be and sets in theimage database.

bl el lcmetssoe taken to Wave Desktop for analysis
with embedded images and cell User can:
counts, «view images
« rename sets/plates

»add/remove flags
«delete images/sets/plates
« export as full resolution TIFF

Figure 13 Imaging and cell counting workflow (3 of 3)
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Important Notes

Day(s) Prior

1

XF software application updates may occasionally become available.
Upon opening or restarting Wave or Imaging and Cell Counting
applications, you may be prompted to update the software. For the
most accurate and up-to-date features, update the applications when
prompted.

Images and the image directory should not be stored on the XFe
Controller as it can cause instability in Wave and Cell Imaging if the
disk becomes full. BioTek and Agilent recommend using a network
location or external hard drive for image storage. (Directions for
networking can be found here.)

Genb software for the Cytation 1 must be licensed from BioTek
Instruments, Inc. For help with the Cytation, Genb software and
licensing, refer to BioTek.

This is the recommended order of operations for running an XF Assay
with Cell Imaging software. Downtime has been minimized or noted
where applicable.

to Assay
Turn on the XFe Analyzer to allow it to warm up and equilibrate
overnight.

Plate cells in Seahorse XF Cell Culture Microplates using cell culture
growth medium.

Hydrate sensor cartridge in Seahorse XF Calibrant at 37 °C in a
non- COy incubator overnight.

Design experiment in Wave. See the instrument user manual for
additional details.

Day of the Assay

Preparing and Running an XF Assay

Refer to the online guides in the links below for assistance in running XF
Assays and for more information on Seahorse XFe Consumables and Kits:

28

Procedures to Run an XF Assay

Seahorse XFe Consumables
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XF Cell Culture Microplate Preparation and Bright Field Imaging

1 Open the Cell Imaging application on the controller and ensure

connectivity; wait for the Ready status in the lower left of the screen.
Agilent Technologies Cell Imaging 1.0.0.5

-o X
Cell Imaging and Normalization

Scan Plate To Start View/Manage Pictures

Recent Captures Date

Cell Count 2018-02-12T14:37:25 Fluorescence  Mine!
Cell Count 2018-02-12T14:30:01  Fluorescence  Mine!
Cell Count 2018-02-12T10:57:16 Fluorescence  Ftest

U Brightfield 2018-02-12708:49:12 Brightfield Frest

2/12/2018 2:37 PM

2/12/2018 2:30 PM

2/12/2018 10:57 AM

2/12/2018 8:49 AM

View All

(@ )) Heater On

4] Ready
E» Cytation Tray
@

Figure 14 Imaging and Cell Counting application main menu

2 Prepare assay medium by supplementing Seahorse XF Base Medium.
Recommendations for each XF Assay Kit can be found in their
respective user guides.

3 Wash XF Cell Culture plate and change media to prepared assay
medium.

Bring washed cell culture microplate to the Cytation instrument and

navigate to the Cell Imaging application. Scan the barcode with the
hand wand to initiate imaging procedure.
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37.0°C

Heater On

Ready
E» Cytation Tray
@) o

5 You will be prompted to name the cell plate. This name will be used for

any set of images that is associated with that plate (both Bright Field
and Fluorescent image sets). Then, click Save.

Name Cell Plate

Q This Cell Plate has not been scanned before.

Please name this Cell Plate.

Plate Name

Cancel

Figure 15 Prompt requesting cell plate name

6 The next screen shows the options for imaging protocols. Prior to the
XF Assay, select Start Brightfield Scan. This page will also display any
image sets that have previously been collected with this cell plate in the

Previous Scan for this Plate menu.

Plate & Scan Menu

Brightfield

Brightfield scans are most commonly used as an
initial check immediately after seeding as well as
post CO2 incubation. They can also be used post
staining.

Afterscanning, the Cytation can provide non-CO2
incubation. A timer will let you know when
outgassing is complete.

U Start Brightfield Scan

Figure 16 Plate & Scan menu

30

Agilent Technologies Cell Imaging 1.0.0.9

Fluorescence & Cell Count

Fluorescence scans are for automated cell
counting. These scans can only be done after the
Seahorse XF assay is complete and the cells have
been stained. The cell counts will be integrated
into the XF Assay result file.

Start Fluorescence Scan

Previous Scans for this Plate
Plate Name: test 01
BC: V0145034217V

Image Set Type Date

Main Menu
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7 Place the cell culture microplate on the holder of the Cytation
instrument. Keep the cell plate lid ON. Use the image in the dialog box
to check if the orientation of the microplate is correct, then click Close
Tray.

NOTE Agilent highly recommends a standard practice of wiping the bottom surface of the
microplate with ethanol/isopropyl for better quality images.

Insert Cell Plate

Plate Barcode: V0427834017V
Plate Name: 20180118 TestPlate

Put your Cell Plate on the Cytation Tray.

* Align Well A1 with the Al mark on the Cytation Tray
* Make sure Plate Cover is on

Close Tray Cancel

Figure 17 Insert cell plate dialog box
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8 The next screen shows the image acquisition screen. On the plate map,
you may select specific wells to be imaged, as is shown, or click Scan All
Wells to image the entire plate.

Agilent Technologies Vortex 0.6.0.3625 -0 X
5{';“"3"‘6 Brightfield Image Acquisition
Plate Map Well Image:
A 1 f 3 5 B T i s i 10 12

*| AD1  AD2 | AO3  AD4 A0S AD6 AD7 A08 | ADS Al0 ALl | A12

®| BO1 BO2  BO3  BO4 BOS BO6 BO7 BO8 | BOS B10 B11 | B12

</ C01 Co2 | CO3 CO4 CO5 CO6 CO7 CO8 | CO9 C10 C11 | C12
° D01 DO2 ' DO3 DO4 DO5 DO6 DO7 DO8 | DOS D10 D11 | D12
MNo Image Available
* EO1 EO2  EO3  EO4 EO5 EO6 EO7 EO8 | EO9 E10 E11 | E12
*| FO1  FO2 ' FO3 | FO4 FOS5 FO6 FO7 FO8 | FO9 F10 F11 | Fl12
5| GO1 GO2 GO3 GO4 GO5 GO6 GO7 GO8 | GO9 G100 G11 @ Gi12

" HO1 | HO2 ' HO3 | HO4 HO5 HO6 HO7 HO8 | HO9 H10  H11  H12

,%7 OO C Scan Selected Wells Scan All Wells
= ’ Zoom O

Heater On Sharpness O

Erighiness (@]

Ready
= To scan a selection of wells highlight the desired wells and click Scan Selected Wells
1% Cytation Tray To sean all wells on the plate click Scan All Wells Export Image
(’:h Help Plate Menu Main Menu

Figure 18 Well selection screen

9 Before images are collected, there are a few initialization steps that may
take up to 2 minutes. (Temperature must reach 37 °C inside the
Cytation and there are auto-exposure and white-balance steps).

System Initializing

System Initialization will take a few minutes. Scanning will
start immediately after initialization is complete.

Figure 19 System initialization
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10 An entire XF96 well plate may take up to 35 minutes to image. During
this time, prepare the XF Assay Kit and load the sensor cartridge.
While the cell plate is in the Cytation instrument, the plate is heated at
37 °C in a non-CO, environment. Cell Imaging will keep a timer for cell
plate outgassing, and the plate will stay in the Cytation until the user
removes it for the XF Assay. Total outgassing time is 1 hour.
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XF Assay Preparation

34

1

Prepare XF Assay Kit Compounds as directed in the appropriate XF
Assay Kit user guide.

Add Hoechst stain to the final reagent in the injection scheme for your
XF Assay. Alternatively, add an injection to the assay for the Hoechst
dye.

a We recommend optimizing the concentration of Hoechst dye needed
for your cells. Our testing was completed with Hoechst 33342 from
Thermo Scientific; Catalog Number P162249.

b Create a titration of Hoechst dye over a plate seeded with the same
number of cells in each well; we recommend a starting point of
20 uM injection solution concentration.

The dye is most active and best imaged within 20-45 minutes of
injection. By default, you may need 3 to 5 measurement cycles after the
final injection. This equates to 18-30 minutes on the XFe96 and 24-40
minutes on the XFe24 after the injection, but before the plate may be
removed to be imaged.

Load prepared reagents in XF Sensor Cartridge drug ports. Ensure
reagents including Hoechst dye are included in the final injection of the
series. Alternatively, designate an additional port after any reagents
have been injected to add the Hoechst dye. Use the table below for
injection port volume recommendations:

XFe96 XFe24
Starting Well Volume (180 pL) Starting Well Volume (500 pL)

Port Injection Volume (pL) Injection Volume (pL)

O oW >

20 56
22 62
25 69
27 75

Begin XFe Assay calibration: using an existing template or create your
own design, load the cartridge and begin calibration. It will take about
20 minutes before the cartridge is calibrated - this can be performed
while the cell plate is in the Cytation instrument.

Once outgassing and cartridge calibration have both completed, remove
the cell culture plate from the Cytation instrument, click Load Cell Plate
in Wave, and move the cell plate to the XFe instrument for reading.
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After XF Assay Completion

The following wells must be seeded and stained to ensure successful initialization of
autofocus and autoexposure:

XF96: D5 and E8
XF24: B3 and C4

1 Upon completion of the XF Assay, remove the plate from the XFe
Analyzer.

2 Carefully remove the sensor cartridge and replace the cell plate lid. The
cells are ready for fluorescent imaging and cell counting.

3 It is helpful to check the cartridge or the XF Assay data for any
injection failures. If the reagent containing Hoechst dye failed to inject,
the cell count will not be appropriate.

4 Scan the plate barcode with the handheld barcode reader. If the plate
has already been imaged, it will not require a new name.

Select Fluorescence & Cell Count,

Place the cell plate on the Cytation tray holder.
Wipe the bottom of the plate with ethanol/isopropyl.
Click Close Tray.

In the image acquisition window, select the wells to be imaged, or select
Scan All Wells to begin imaging. Fluorescence imaging takes about 15-20
minutes to scan the entire plate.

© 00 N o

Images are not available for review while they are being collected. Once the Cytation 1 has
collected all images and counted each well, the images will be available for review.
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10 Review fluorescent images and cell counts in the Imaging and Cell
Imaging application. Notice that there is an option to View Counted Cells
(highlighted in the figure below). This option shows a 'masked' image,
highlighting the objects that were counted.

Note that the algorithm uses the brightness of the stained nuclei to determine whether it is
an 'object’ or not. Some common counting problems include variation in intensity and failed
dye injections.

Be sure to optimize the concentration and incubation time for Hoechst dye and check for
injection failures.

Agilent Technologies Cell Imaging 0.4.0.7 - X
Fluorescence Image Acquisition
Cell Count 2018-02-23T14:44:06 Well Image: C10 Cell Count: 10734

| ooo oooaao .
| oo oooaaa
. Do ooooooo
| mnooooooow
| oo oooooooo

&
S
=)
-
(&
iy
(=
=
b=
=
2

2 | EA &

o]
37 O Scan Completed!

Heater On

Contrast @r

Ready

Brightness &

5, cypationTray View Counted Cells |/ Export Image
® Help Plate Menu Main Menu

Figure 20 Reviewing fluorescent images

11 If the images are satisfactory and the cell plate and sensor cartridge
are no longer needed, they may be discarded appropriately.
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XF Data Normalization

1 After image collection is complete, image review and data normalization
can be performed in Wave. From the Wave application, open the
appropriate assay file.

2 To review images, use the Add button and choose Well Images. This adds
the images to your available Views.

‘Wave 260

201BFeb16 Pheno Kit_AS49__ 201BFeb09_Support Training.

? '—; ‘Summary Quick View ‘Well Images

Normalize Madify Summary

nctions Quick View

Overview

1

Baseline = OFF Background Correction |/

Measurement Rate | ECAR

OCR vs. ECAR

»

Display | Group

+ -
Oligo + FO

40

35-

30

25

& ECAR (mpH/min)

0 5 10 13 20 25 30 35 40 43
Time [minutes)

Figure 21 Adding images to your available views
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3 On the Well Images tab, choose Bright Field or Fluorescent images from
the Image Sets menu. Click on each well to review the images. You may
also compare image sets and flag wells using the star in the upper
right-hand corner of the images (highlighted in yellow).

e 260 -8 %

01RFeb0_Suppor Traing.

Plate Name: 16Feb2018 Pheno Test AS498&HepG2 20158 (120 s
Image Sets Brightfield 2018-02-16T11:05:23 HealMap _OFF Well lmage: D06
A 1 2 3 a 5 5 7 B 9 0 1 2 x
(1] Brighthels 2015-02-16711:05:23 R @] @ @ @ @] ] = @
[ cell Count 2018-02-16T13:2247 : @] @] ] %] =] 1] ) (%)
‘ ] @] ] i %) %] % ]
[ Brightieid 2018-02-22708:21:18 o @] @] [ @ % (] i @)
[(E] Cell Count 2015-02-22T08:23:59 ‘ (%] [%] [] (%) (%] %] [ (4]
! 1) 1] [ (%) (%) 1) %) %)
7 Brightheld 2018-02-22T0B:31:26 . @] o = = - [©] @] T ™ -
[ ceit €ount 2012-02-22T08:24:45 " (] (] ] (%] (%) [1%7] 1%} [} [ (%)
Import Flags Inport Selected Compare Wells
Zoom O
Conmmat @]
R
Compare Sets Aemove Image Imgort Image

37.0°C

Heater On
Frady
=1
[7]) imaqe imported and embecied in assay fie
[ Probes mage svailable but ot imparted

Figure 22 Flagging an image for comparison

4 Heat Maps are also available in this view. The heat map uses cell count
values to visually display cell counts. Click the Heat Map drop-down list
box and choose to either view by group, or across the entire plate:

Plate Name: 16F2b2018 Phano Test_AS49&HepG2

Plate Name: 16Feh2018 Pheno Test_AS4S&HepG2

e Seis i ] 7071807161 105:21 Bright ikl 2018-07-1611 821571 - e [
(o] EELD w2 e wu xe e oo wm o ™
un w wm ww om o wm e we o o
@ B e n wr am e wen e S o wm
T e e o
Ercro 918 02 Z2nvsanE
3w 2 e w nw wmam o es e mn
] eoiConrs S000-3 7708 5008 = PR w | wm | um o P =
e moarsoRaca | [ Gompars

Figure 23 Viewing heat maps
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5 To Normalize XF Data using the cell counts collected, navigate to the
Normalize tab of the Functions options. Notice that there should be
an (@ symbol noting that Cell count data available.

6 Click Import to fill in the table with cell counts. Note that wells defined
as background will remain empty (there are no cells in these wells).

Wave 26.0

201BFebl6 Pheno Kit_AS49.. 2018Feb09_Support Training...

Edit Normalization Mode

Normalization Unit Scale Factor
1000 Cells 1000
Normalization Values
Select All ‘ 1 2 3 4 5 6 7 8 9 10 1 12
e A 3312 5,072 5,334 7,643 5,361 4,270 5,747 8,028 10,633 11,842
B 3320 4723 6950 7320 483 4185 6,826 9,536 13271 11968
Clear All Data
c 3317 5,153 7,524 8,155 10177 4333 6177 8356 12,188 11,750
Cell count dats D 2,449 4,901 7954 7,780 10632 3,506 5,806 10429 11,375 19352
auzilable
E 3213 4,643 8177 7,583 10341 4552 5,869 7,855 11,731 12,300
Import
F 3,228 4,949 7.847 7,401 10919 4534 7246 8,552 11542 12325
G 2372 4,693 7873 7134 10,736 4771 3,331 8,563 11,846 13,018
H 3291 4,045 6,545 7.609 11538 4389 6,689 7353 8351 13378

Figure 24 Normalizing XF Data using the cell counts collected

7 Upon cell count import, the default scale factor is 1000 and the
normalization unit is 1000 cells. Ensure scaling is appropriate, then
click Apply to view normalized XF Data.

Please note that importing images and cell counts with Wave Desktop (on a PC) is not
currently supported with the use of the Cytation 5. Images and cell counts must be imported
to the .asyr file using the XFe Analyzer's Controller.
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.. Licensing Seahorse XF Imaging and
. Cell Counting Software

Logging into SubscribeNet 42
Registering the Software 43

The Cell Imaging software allows a 30-day window for initial registration.
If the controller cannot be networked, registration can be completed on a
PC or laptop. An authorization code required for activating the XF Imaging
and Cell Counting software license is delivered along with the rest of the
normalization solution components.

Agilent Technologies a
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Logging into SubscribeNet

42

Agilent SubscribeNet is an Electronic Software Delivery service provided
by the Global Software Distribution Center for Agilent employees and
Non- Agilent workers.

For customers of Agilent log in here:
https://agilent.subscribenet.com

For Agilent employees log in here:

http://softserv.cos.agilent.com/register.html
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Registering the Software

1 To connect the controller to a local network, refer to the Networking
guide.

2 Open SubscribeNet and select CLICK HERE at the bottom of the screen

Helping our customers achieve

- Agilent Technologies Our measure is your success.

better results, faster than ever.

Electronic Software and License Delivery

Please login. Your Login ID is your Email address.
Login ID

Password

Remember my password until | logout

If you have forgoiten your login ID, password, or are not sure whether you have an account use our Password
Finder.

SubscribeNet new account registration.

Customers who have an authorization code from their Agilent product purchase maff CLICK HERE §p register

and create a new SubscribeNet Account and Login 1D .

Figure 26 Registering a new account
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3 Fill in the required fields and click Submit.

Ir customers achieve

- Agilent Technologies Our measure is your success.

Electronic Software and License Delivery

Registration Information

Registration information is used to create a new SubscribeMNet Account and Login |D (email address) for the
Account. An autherization code you received from your preduct purchase is reguired.

Important Email Notes

« Please ensure the email address is entered correctly or you will not receive a welcome email with your
Login ID and Password.

« |f the email entered has already been used for an account Login 1D, you will not receive a welcome email.
The new account will display as an additional selection after you log in to SubscribeNet

* Indicates a required field

Authorization Code:*

Email:*

Re-enter Email to Verify:*

Company:*

Department:*

First Name:*

Last Name:*

Job Title:

Address 1:*

Address 2:

Address 3:

City:*
State/Province:*

- Please Choose One —- v |

Postal Code:

\

\

\

\

\

\

\

\
Phone:* ‘

\

\

\

\

‘ -

\

‘ -

Country:* - Please Choose One -- v |

Privacy Statement | Terms of Use | Agilent Home | © Agilent 2000-2015 | EU Safe Harbor Motice

Figure 26 Registration information
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After registration has been submitted, a new screen will appear with

the license.

Agilent Technologies Our measure is your success.

Your Login is: hardave.dhaliwal@agilent.com

Product List Product Information

Product Search Seahorse Licenses
Entitlements

Licenses

navigation panel.

Helping our customers achieve

better results, faster than ever.
Account: Agilent Tech Inc,Quality Assurance

Electronic Software and License Delivery

To Generate, View, and Download License files, click on the Generate or View Licenses button on fhe left-

1q

Register Authorization Code Select & version,

Generate or View Licenses

. A
T LT T New Versions | Frevious Versions

Manage Licenses by Host Version Description Date Available
Administration I 10 Seahorse XF Cell Counting Software License Jan 11, 2018

Account Members

Change Password

Figure 27 Selecting the license

4 Select the Seahorse XF Cell Counting Software License. A screen will appear,
prompting for an Authorization Code. This is found on the sticker

received with the upgrade.

Enter the code and click Submit.

(2]

Agilent Technologies BRI EETCNERT @ IT0H=EES

“four Login is: hardave.dhaliwal@agilent.com

m Electronic Software and License Delivery

Product List

Register Authorization Code

Helping our customers achieve

better results, faster than ever.

Account: Agilent Tech Inc,Quality Assurance

Product Search Authorization Codes represent license or subscription products that can be added to your Account License Foc

using this page
Entitlements

You may enter up to ten Authorization Codes, separated by semicolons.
- —
Licenses
Please enter an Authorization

Register Authorization Code Code:

Generate or View Licenses

Figure 28 Entering the authorization code
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6 The next dialog prompts the generation of the license. Choose the check
box next to the desired license and then click Generate.

Generate

Seahorse XF Cell Counting Software
Total Number of Licenses: 1

b
—Version Descripfion
1.0 Seahorse XF Cell Counting Soffware License
1 Available

Figure 29 Generating the license

7 The next screen requires the MAC address. Find the MAC address on
the controller.

a Open the Cell Imaging application.
b Navigate to the Help menu to find and copy the MAC address.
—_—eeeeee

Help

Software Info

Version: 0.6.0.3651

Agilent License: Valid

MAC Address: 1C-EE-C9-00-55-76
Copynght & UL

Agilent Technologies.
All Rights Reserved.

Figure 30 Finding the MAC address
8 Paste the MAC address into the Host ID MAC Address bar.

Mumber of
Licenses
Available

1

Version Descriplion
1.0 Seahorse XF Cell C«m.mlim Software License
HostID  MAC Address

Figure 31 Adding the MAC address

9 Choose the check box next to the desired license and then click
Generate.
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10 Click Download License File. This file will be saved in the "Download"
folder. The title of the file will be the MAC address.

11 Copy this license file to the folder path shown below:

» ThisPC » 05(C) » Program Files (x86) » Seahorse Bioscience * Cell Imaging

Figure 32 License path
12 Rename the file to "vortex.lic"

13 Return to the Help menu in the Cell Imaging application to verify that
the Agilent License is valid. The software may need to be closed and
reopened to show the status.

14 If a controller needs to be replaced, the license may be returned for
another and setup on the new controller. In SubscribeNet, click Return
and follow the instructions.

License Returns

Generated licenses may be returned to the License Pool by clicking the "View Details’ link, and then clicking the
‘Return’ button_

More Help...
Entitliement Number: LicenseXSAT759162
Entitlement Date: Jan 29, 2013
View
View |
Seahorse XF Cell Counting Software
Total Number of Licenses: 1
Mersion Descriplion
1.0 Seahorze XF Cell Counting Soffware License
0 Available
[ View Details
License Cuantity: 1 Expiration Date: permanent
MAC Address: 1C-EE-C9-00-55-T6 Retum |
Generated By: Hardave Dhaliwal on Feb 9, 2018 ——
About Return
About Upgrade

View I

Figure 33 License returns
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